
Shelly Cashman: Microsoft Excel 2019

Module 1: Creating a Worksheet and a Chart
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Objectives (1 of 2)

• Start an app

• Identify the components of the Microsoft Office ribbon

•Describe the Excel worksheet

• Enter text and numbers

•Use the Sum button to sum a range of cells

• Enter a simple function

• Copy the contents of a cell to a range of cells using the fill 
handle

•Apply cell styles
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Objectives (2 of 2)

• Format cells in a worksheet

• Create a pie chart

• Change a worksheet name and sheet tab color

• Change document properties

• Preview and print a worksheet

•Use the AutoCalculate area to display statistics

• Correct errors on a worksheet

•Use Microsoft Office Help
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Project: Real Estate Budget Worksheet
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Project: Pie Chart Showing Monthly 
Expenses by Category
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Starting and Using Excel (1 of 3)

•What is Excel?

•A powerful spreadsheet app that allows users to organize 
data, complete calculations, make decisions, graph data, 
develop professional-looking reports, publish organized 
data to the web, and access real-time data from websites

• Four major parts:

-Workbooks and worksheets

-Charts

-Tables

-Web support
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Starting and Using Excel (2 of 3)

•To Start Excel and Create a Blank Workbook

• If necessary, scroll to display the Excel 2019 app on the 
Start menu

• Click the Excel 2019 app to run the Excel app and display 
the Excel start screen

• Click the Blank workbook thumbnail on the Excel start 
screen to create a blank Excel workbook in the Excel 
window
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Starting and Using Excel (3 of 3)
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Running and Using an App (1 of 2)

•Excel Window

•Worksheet

• Scroll Bars

• Status Bars

• Ribbon

•Mini Toolbar (right click / shortcut menu)

•Quick Access Toolbar (customizable)

• KeyTips (ALT key)

• Formula Bar (expandable)

• Tell Me Box (Search)

•Microsoft Account Area
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Running and Using an App (2 of 2)

•To Display a Different Tab on the Ribbon

• Click Insert on the ribbon to display the Insert tab

• Click the View tab, click Page Layout tab, then click Insert 
tab
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Selecting a Cell

•Make the cell active

•Use the mouse

•Use the arrow keys

• Cell is active when a heavy border surrounds the cell
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Entering Text (1 of 4)

•To Enter the Worksheet Titles

• Run Excel and create a blank workbook in the Excel window

• Click the A1 to make the cell A1 the active cell

• Type desired text (“Frangold Real Estate Budget”)

• Click the ENTER button to complete the entry and enter the 
worksheet title

• Click cell A2 to select it (“Monthly Estimates”)

• Click the ENTER button to complete the entry and enter the 
worksheet subtitle
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Entering Text (2 of 4)

•To Enter Column Titles

• Click cell A3 and enter a column title (“Income”)

• Press the RIGHT ARROW key to enter a column title and 
make the cell to the right the active cell

• Repeat the previous steps until all column titles are 
entered. Click the Enter box after entering the last column 
title (January, February, March, May, June, July, August, 
September, October, November, December, Total)

• Click cell A8 and enter the expenses column titles 
(Expenses, January, February, March, May, June, July, 
August, September, October, November, December, Total)
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Entering Text (3 of 4)
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Entering Text (4 of 4)

•To Enter Row Titles

• Click cell A4 and enter a row title (“Commission”)

• Press the DOWN ARROW key to enter a row title and make 
the cell below the current cell the active cell

• Repeat the previous steps for cell A5 & A6 until all row 
titles are entered (“Interest”, “Total”)

• Click cell A9 ~ A19 and repeat the above steps to enter row 
titles for expenses (Rent, Utilities, Advertising, Website, 
Printing, Office Supplies, Gas, Miscellaneous, Total, “ ”, Net)
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Entering Numbers

• In Excel, you can enter numbers into cells

• If a cell entry contains any other keyboard character, Excel 
interprets it as text and treats it accordingly

•To Enter Numbers

• Click cell B4 to select it

• Type desired number and then press the RIGHT ARROW key 
to enter the data in the selected cell and make the cell to 
the right the active cell

• Continue until all numbers are entered (See Slide 1 for all 
the data)
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Calculating Sums and Using Formulas (1 of 2)

•To Sum a Column of Numbers

• Click the first empty cell (B6) below the column of numbers 
to sum

• Click the AutoSum button [HOME tab | Editing grp] to 
display a formula in the formula bar and in the active cell

• Click the Enter box in the formula bar to enter a sum in the 
active cell

• Repeat above steps to enter the SUM function in other 
locations (Income: cells C6 ~ M6; Expenses: cells B17 ~ M17)
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Calculating Sums and Using Formulas (2 of 2)
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Using the Fill Handle to Copy a Cell to 
Adjacent Cells (1 of 3)

•To Copy a Cell to Adjacent Cells in a Row
• With the cell containing the contents to fill across the row active, 

point to the fill handle (lower-right corner of the cell) to activate it

• Drag the fill handle to select the destination area to display a 
shaded border around the source area and the destination area

• Release the mouse button to copy the SUM function from the 
active cell to the destination area and calculate the sums 

• Repeat the above steps to copy the SUM function to other ranges
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Using the Fill Handle to Copy a Cell to 
Adjacent Cells (2 of 3)

•To Calculate Multiple Totals at the Same Time

•Highlight a range at the end of rows or columns of numbers 
to total (N4 ~ N6)

• Click the AutoSum button on the HOME tab to calculate 
and display the sums of the corresponding rows

• Repeat the above steps to calculate and display the sums of 
the corresponding rows (N9 ~ N17)
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Using the Fill Handle to Copy a Cell to 
Adjacent Cells (3 of 3)
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Calculating Average, Maximum, and 
Minimum Values (1 of 2)

•Calculating the average, maximum and minimum

• The AutoSum list lets you calculate Average, Maximum, 
Minimum and other values

•To Enter a Formula Using the Keyboard

• Select the cell that will contain the formula (B19)

• Type the formula in the cell to display it in the formula bar 
and in the current cell and to display colored borders 
around the cells referenced in the formula (=b6-b17)

• Click the cell to the right (C19) to complete the formula and 
to display the result in the worksheet.
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Calculating Average, Maximum, and 
Minimum Values (2 of 2)

•To Copy a Cell to Adjacent Cells in a Row Using the Fill 
Handle

• Select the cell (B19)

•Drag the fill handle to select the destination area (C19-N19)
to display a shaded border around the source area and the 
destination area

• Release the mouse button to copy the function from the 
active cell to the destination area and calculate the results
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Saving the Project

•To Save a Workbook

• Click File on the ribbon to open Backstage view

• Click Save As, then Click This PC to display the default save 
location

• Click the More options link to display the Save As dialog 
box

• Type desired file name in the File name text box

• Click Save button
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Formatting the Worksheet (1 of 11)
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You format a worksheet 
to enhance the 
appearance of 
information by changing 
its font, size, color, or 
alignment.

A formatted sheet is not 
only easier to read but 
also more professional.



Formatting the Worksheet (2 of 11)

•To Change a Cell Style

• Click the desired cell (A1) and then click the Cell Styles 
button (HOME tab | Style group) to display the Cell Styles 
gallery 

• Point to the Title cell style in the Titles and Headings area 
of the Cell Styles gallery to see a live preview of the cell 
style in the active cell

• Click the Title cell style to apply the cell style to the active 
cell
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Formatting the Worksheet (3 of 11)

•To Change the Font

• Click the desired cell (A2) for which you want to change the 
font 

• Click the Font arrow (HOME tab | Font group) to display 
the font gallery

• Point to desired font (Arial Narrow) in the Font gallery to 
see a live preview of the selected font in the active cell

• Click the desired font to change the font of the selected cell
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Formatting the Worksheet (4 of 11)

•To Apply Bold Style to a Cell

• Click a cell (A1) to bold and then click the Bold button on the 
HOME tab to change the font style of the active cell to bold

• Repeat above to bold cell A2
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Formatting the Worksheet (5 of 11)

•To Increase the Font Size of a Cell Entry

•With the desired cell (A2) selected, click the Font Size 
arrow (HOME tab | Font group) to display the Font Size 
gallery

• Point to the desired font size (16) in the Font Size gallery to 
see a live preview of the active cell with the selected font 
size

• Click the desired font size in the Font Size gallery to change 
the font size in the active cell
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Formatting the Worksheet (6 of 11)

•To Change the Font Color of a Cell Entry

• Select the cell (A1) for which you want to change the font 
color and then click the Font Color arrow on the HOME tab

• Point to the desired color in the Theme Colors area of the 
Font Color gallery to see a live preview of the font color

• Click the desired theme color {Green, Accent 6 (col 10, row 
1)} to change the font color of the worksheet title in the 
active cell

• Click cell A2 and repeat the above
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Formatting the Worksheet (7 of 11)

•To Center Cell Entries across Columns by Merging Cells

•Drag to select the range of cells you want to merge and 
center (A1:N1)

• Click the “Merge & Center” button (HOME tab | Alignment 
group) to merge the selected range and center the 
contents of the leftmost cell across the selected columns

• Repeat the above steps to merge and center (A2:N2)
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Formatting the Worksheet (8 of 11)

•To Format Rows Using Cell Styles
• Click a cell and drag to select the desired range (A3:N3)

• Click the Cell Styles button (HOME tab | Styles group) to display 
the Cell Styles gallery

• Click a Heading cell style to apply the cell style (Heading 1) to 
the selected range

• Then click the Center button (HOME tab | Alignment group) to 
center the column headings in the selected range

• Repeat the above steps to format (A8:N8)

• Format A6:N6 and A17:N17 with Total cell style format

• Format A19:N19 with the Accent6 cell style format

• Format A4:N4, A9:N9, A11:N11, A13:N13, A15:N15 with 20%-
Accent 6 cell style format

• Format A5:N5, A10:N10, A12:N12, A14:N14, A16:N16 with 40%-
Accent6 cell style format
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Formatting the Worksheet (9 of 11)

•To Format Numbers in the Worksheet

• Select the range of cells (B4:N4) containing numbers to format 

• Click the desired format (Accounting) (HOME tab | Number 
group) to apply the format to the cells in the selected range

• Select the range B5:N5 And click the Comma Style button 
(HOME tab | Number group) to apply comma style format
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Formatting the Worksheet (10 of 11)

•To Format Numbers in the Worksheet (Continued)

• Select the range of cells (B6:N6)

• Click the “Accounting Number Format” button to apply the 
accounting number format

• Format B9:N9, B17:N17, and B19:N19 with the accounting 
number format

• Format B10:N16 with the Comma Style format

• Click A1 to deselect ranges
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Formatting the Worksheet (11 of 11)

•To Adjust the Column Width

• Point to the boundary on the right side of the column 
heading (A) of which you want to change the size to change 
the mouse pointer to a split double arrow

•Double-click on the boundary to adjust the width of the 
column to the width of the largest item in the column

• Repeat the above steps for columns B through N

•To Use the Name box to Select a Cell

• Click the Name box in the formula bar and then type the 
cell reference of the cell you wish to select (A3)

• Press the ENTER key to change the active cell in the Name 
box
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Adding a Pie Chart to the Worksheet (1 of 2)

•Excel provides 17 chart types for you to choose

•A pie chart shows the contribution of each piece of data to the 
whole of data

•To Add a Pie Chart

• Select the range (A9:A16, N9:N16) to identify the category 
names and data for the pie chart

• Click the “Insert Pie or Doughnut Chart” button (INSERT tab | 
Charts group) to show the Insert Pie or Doughnut Chart gallery

• Click Pie in the 2-D category to insert the chart

• Click the chart title to select it then drag and select all the text

• Type a chart title (Monthly Expenses) to change the title

•Deselect the chart title
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Adding a Pie Chart to the Worksheet (2 of 2)

•To Apply a Style to a Chart

• Click the Chart Styles button (to the right of the chart) to 
display the Chart Styles gallery

• Click a style (Style 6) in the Chart Styles gallery to change 
the chart style to the desired style

• Click Chart Styles button to close the Chart Styles gallery
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Changing the Sheet Tab Names and Colors 
(1 of 2)

•To Move a Chart to a New Sheet

• Click the Move Chart button (CHART TOOLS DESIGN tab | 
Location group)

• Click New sheet to select it (Move Chart dialog box) and 
then type a title (Monthly Expense Chart) for the 
worksheet that will contain the chart

• Click the OK button to move the chart to a new chart sheet 
with a new sheet tab name
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Changing the Sheet Tab Names and Colors 
(2 of 2)

•To Change the Sheet Tab Name and Color

•Double-click the sheet tab (Sheet1) you wish to change in 
the lower-left corner of the window

• Type a new name ( 31 characters) as the worksheet tab 
name (Monthly Finances)

• Right-click the sheet tab in the lower-left corner of the 
window to display a shortcut menu

• Point to Tab Color in the Tab Color gallery

• Click the desired color in the Theme Colors area to change 
the color of the tab { Green, Accent 6 (col 10, row 1) }
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Document Properties

•To Change Document Properties

• Click File on the ribbon to open the Backstage view and 
then click the Info tab in the Backstage view to display the 
Info gallery

• Click to the right of the property category to display a text 
box

• If necessary, click the Properties button to display the 
Properties menu
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Printing a Worksheet

• To Preview and Print a Worksheet in Landscape Orientation

• In Backstage view, click the Print tab to display the Print screen
• Verify that the printer listed on the Printer Status button will print 

a hard copy of the workbook. If necessary, click the Printer Status 
button to display a list of available printer options and then click 
the desired printer to change the currently selected printer

• Click the Portrait Orientation button in the Settings area and then 
select Landscape Orientation to change the orientation of the page 
to landscape.

• Click the No Scaling button and then select “Fit Sheet on One 
Page” to print the entire worksheet on one page

• Click the Print button in the Print gallery to print the worksheet in 
landscape orientation on the currently selected printer

• When the printer stops, retrieve the hard copy
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Viewing Automatic Calculations

•To Use the AutoCalculate Area to Determine a 
Maximum

• Select the range of which you wish to determine a 
maximum (B19:M19), and then right-click the status bar to 
display the Customize Status Bar shortcut menu 

• Click Maximum on the shortcut menu to display the 
Maximum value in the range in the AutoCalculate area of 
the status bar

• Right-click the status bar and click Maximum on the 
shortcut menu to deselect it.
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Correcting Errors (1 of 8)

•Correcting Errors after Entering Data into a Cell

• If the entry is short, select the cell, retype the entry 
correctly

• If the entry is long, use the EDIT mode to perform in-cell  
editing

•Double-click the cell containing the error to enter EDIT 
mode
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Correcting Errors (2 of 8)

•Undoing the Last Cell Entry

• The Undo button on the Quick Access Toolbar allows you 
undo up to 100 previous actions
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Correcting Errors (3 of 8)

•Clearing a Cell or Range of Cells (select the cell or range 
first)

• To Clear Cell Entries Using the Fill Handle

-Drag the fill handle back into the selected cell or range

• To Clear Cell Entries Using the Shortcut Menu 

-Click Clear Contents on the shortcut menu

• To Clear Cell Entries Using the Delete Key

• To Clear Cell Entries and Formatting Using the Clear Button

-Click the Clear button (Home tab | Editing group) -> Clear All

• To Clear Formatting Using the Cell Styles Button

-Click Cell Style button (Home tab | Style group) -> Normal
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Correcting Errors (4 of 8)

•Clearing the Entire Worksheet

• To Clear the Entire Worksheet

-Click the Select All button on the worksheet (above row 1 
identifier and to the left of the column A heading)

-Click the Clear button and then click Clear All (Home tab | 
Editing group)
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Correcting Errors (5 of 8)

•To Obtain Help Using the Search Text Box

• Click Help on the ribbon to display the Help tab

• Click the Help button to display the Help pane

• Type a word in the Search help box (functions)

• Press Enter to display the search results

• Click the Close button

• Click Home on the ribbon to display the Home tab
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Correcting Errors (6 of 8)

•To Obtain Help Using the Tell Me Box

• Type desired text in the Tell Me box and watch the search 
results appear (header and footer)
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Correcting Errors (7 of 8)

•To Save a Workbook with a Different File Name

• Click File on the ribbon to open Backstage view

• Click Save As in Backstage view to display the Save As 
screen

• Type the desired file name in the File name text box to 
replace the existing file name

• Click the Save button
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Correcting Errors (8 of 8)

•To Sign Out of a Microsoft Account

• Click File on the ribbon to open Backstage view

• Click Account to display the Account screen

• Click the Sign out link

• Click Yes

• Click the Back button in the upper-left corner of Backstage 
view to return to the document

• Click Close to close the workbook and exit Microsoft Excel. 
If prompted, click Yes
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